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ÝÝ Create formulas with functions

ÝÝ Use AutoSum

ÝÝ Use relative and absolute cell references in 
formulas

ÝÝ Define names for cells and ranges

ÝÝ Use names in formulas

3 Performing 
Calculations Using 
Functions

EXCEL

I
n this chapter, you will begin using 

functions in your formulas to make 

complex calculations quicker 

and easier. You will also learn about the 

difference between a relative and an 

absolute reference and practice using both 

in your formulas.
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76  Excel Chapter 3: Performing Calculations Using Functions

	 Project: Tracking Progress
As an instructor at LearnFast College, you have already recorded the student grades for 
your Introduction to Business course. Now you will use functions to perform a variety of 
calculations that will help you analyze the students’ performance.

Using Functions in Formulas
Functions are an important part of Excel. They allow you to do much more than simple mathematical 
operations. For example, adding two or three cells together is not a problem; however, if you needed 
to add up hundreds or even thousands of cells, it would be quite the tedious task! You would need a 
formula such as: =A1+A2+A3+A4… and so on.

The SUM function, in this case, is easier because it allows you to specify a range instead of individual 
cells. The function then tells Excel what operation to perform on the range, in this case addition. This 
is one of the reasons Excel is much more efficient than using a calculator!

Formulas with functions are inserted into a cell starting with the equals (=) sign, just like other 
formulas. This is followed by the function name and one or more arguments inside parentheses. An 
argument is the name for the numbers, cells, or ranges used in the function.

The function name 
SUM follows the = sign.

The function arguments must be 
placed inside parentheses. The argument 
is the range A1:A12, so Excel will add all 
of the values contained in that range.

This function has three arguments; 
two individual cells, A1 and A4, as well 
as the range A7:A12, separated by commas.

Functions can be typed directly into a cell, if you know the name of the function you wish to use, or 
inserted a number of other ways. Functions are available from the Formulas tab on the Ribbon, by using 
AutoSum, or by using the Insert Function button on the Formula Bar. The most common functions can 
be inserted quickly and easily from the AutoSum drop-down menu on the Home tab of the Ribbon.


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Using Functions in Formulas  77

When you insert a function by typing, Excel will suggest names for functions as you type. For 
example, typing =s will generate a list of functions that start with the letter S; you can ignore the 
prompt and type the full function name or double-click one of the suggestions that appears.

DEVELOP YOUR SKILLS: E3-D1

In this exercise, you will create a formula using the SUM function to calculate the final grade for each 
student.

	 1.	 �Start Excel; open E3-D1-SummerGrades from your Excel Chapter 3 folder and save it as: 
E3-D1-FallGrades

	 2.	 �On the Final Grades worksheet select cell G6, and then type =SUM(C6:F6) and click  
Enter .

The formula in the Formula Bar shows the SUM function, and the total of cells C6:F6 is displayed in 
cell G6. The final grade for the first student, Ashley, is 37%.

Currently there are only two grades being added (28% and 9%). The other grades will be added to the 
total once they are calculated on the Quizzes and Exam worksheets.

	 3.	 �In cell G7, type =SUM( and use the mouse to select the range C7:F7; then click Enter .

It’s good practice to type the closing parenthesis after the function arguments, but notice in the 
Formula Bar that Excel automatically inserts it for you. The sum for the second student, Atif, now 
shows 36%.

	 4.	 �Point to the fill handle in cell G7 and double-click to fill the formula down column G.

	 5.	 �Save the workbook.

The AutoSum Feature
The AutoSum feature not only makes it easy to find some of the simplest functions, it also helps 
identify and enter the range of cells you are most likely to use in your function. Often when you have 
a column of numbers, you want to add a total at the bottom of the column. In a row, the total would 
be placed on the right side of the row.

AutoSum will automatically search for adjacent data, either directly above or to the left of the 
selected cell. Therefore, selecting the cell at the bottom of a column or the right side of a row and 
clicking AutoSum will very quickly enter the SUM function, as well as the range of cells necessary 
to add all the numbers in that column or row. If necessary, you can alter the range Excel selects by 
dragging to select the desired cells before completing the entry.

Another option is to select the data in the row or column first and then click AutoSum.

SUM, AVERAGE, COUNT, MAX, and MIN
The SUM function is just one of the AutoSum options; other frequently used functions can be found 
via the AutoSum drop-down menu. These functions take a set of numbers identified in the arguments 
and can be used to find the average, count how many numbers are in the set, or locate the highest 
or lowest value. Similar to AutoSum, these functions automatically search for adjacent data, either 
directly above or to the left of the selected cell.
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78  Excel Chapter 3: Performing Calculations Using Functions

AUTOSUM FUNCTIONS

Function Name Description
SUM Adds the values in the cells

AVERAGE Calculates the average of the values in the cells

COUNT
Counts the number of cells that contain numerical values; cells 
containing text and blank cells are ignored

MAX Returns the highest value

MIN Returns the lowest value

ÍÍ Home→Editing→AutoSum  menu button �

Insert Function
For more complex functions, the Insert Function button opens a dialog box that allows you to search 
for functions and enter function arguments. In the Insert Function dialog box you can search for your 
desired function by keyword or browse by category. After choosing the function, the Function Argu-
ments dialog box opens, from which you enter the numbers, cell references, or criteria to use in the 
function.

View the video “Entering a Formula Using Insert Function.”

DEVELOP YOUR SKILLS: E3-D2

In this exercise, you will use AutoSum to calculate the total each student earned on their quizzes, as well as 
to calculate the class average for each quiz.

	 1.	 �Save your workbook as: E3-D2-FallGrades

	 2.	 �Click the Quizzes worksheet tab and select the empty cell under Quiz Total for Ashley, cell H6.

	 3.	 �Choose Home→Editing→AutoSum .

The SUM function is entered into cell H6 with the range C6:G6. Excel finds five adjacent cells to 
the left of cell H6 containing numerical data, so the range C6:G6 is automatically entered into the 
function arguments within parentheses.

	 4.	 �Click Enter  to finish the entry and show the result of the formula, 404, in cell H6.

	 5.	 �Use the fill handle to copy the formula in cell H6 down the column for the rest of the students.

Next you will calculate the class average for each quiz.

	 6.	 �In cell A18, enter: Class Average

	 7.	 �Format cell A18 with bold and italic formatting, and then merge and center cells A18 and B18.

	 8.	 �Select cell C18 and choose Home→Editing→AutoSum  menu button �→Average.

	 9.	 �Complete the entry in cell C18 and then use the fill handle to copy the average formula from 
cell C18 to the right, into the range D18:G18 below all five quizzes.
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Using Relative and Absolute Cell References  79

	10.	 �Decrease the decimal in the range of selected cells so only one decimal place is displayed and 
then apply bold formatting and a top cell border.

Now you want to find the average for each student.

	11.	 �Insert a new column to the left of column I.

	12.	 Enter Student Average into cell I4.

	13.	 �Select cell I6 and choose Home→Editing→AutoSum  menu button �→Average but do 
not complete the entry.

This time AutoSum selects the range C6:H6, which is incorrect because the average for the five quizzes 
should not include the total. Now you will select the correct range.

	14.	 �Use the mouse to drag and select the correct range C6:G6 and then complete the entry.

	15.	 �Use the fill handle in cell I6 to copy the formula down the column for the rest of the students.

Next you need to calculate the exam grades for each student.

	16.	 �Click the Exam worksheet tab and select the empty cell under Exam Total for Ashley, cell H6.

	17.	 �Use AutoSum to add the Section 1 to Section 5 exam marks for Ashley, and then copy the 
formula down column H for the other students.

	18.	 �Save your work.

Using Relative and Absolute Cell References
Cell references make it easier to copy formulas when you want to perform the same calculation with 
new numbers each time. Without cell references, each calculation would need to be typed individu-
ally, like with a calculator—slowly and tediously. A relative cell reference, which is the default in Excel, 
is one in which the location of the cell remains relative to the cell that contains the formula. This 
makes repeating the same calculation many times quick and easy! 

For example, if the formula =A3-B3 is in cell C3, the relative position of A3 is two cells to the left of 
C3, and B3 is one cell to the left of C3. When you copy the formula to another cell, the cell refer-
ences change to be in the same relative position. So, if you copy the formula =A3-B3 from cell C3 
down to cell C4, the formula there will be =A4-B4. Excel updates the new cell references to be in the 
same relative position to cell C4; that is, two cells to the left and one cell to the left.

Remember that a relative cell reference changes when it is copied.

The original formula is seen in the Formula  
Bar, with relative references to both cells  
A3 and B3.

Tip!

The copied formula is displayed with 
the new cell references A4 and B4.
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80  Excel Chapter 3: Performing Calculations Using Functions

Absolute Cell References
In some situations, you do not want the cell reference to change when you move or copy the formula. 
To ensure the cell reference does not change, use an absolute cell reference. You can think of an abso-
lute cell reference as being locked in place; that is, the cell reference will not change when copied to 
other cells.

To make a cell reference absolute, start with a relative cell reference such as A1 and add a dollar sign 
in front of the column and row components, like this: $A$1.

There are two ways to create an absolute cell reference:

	 1.	 �Type the cell reference and include dollar signs in front of the column and row references.

	 2.	 �Use the mouse pointer to select the cell and then tap [F4] on the keyboard, which inserts both 
dollar signs into the cell reference at once.

Example: If the formula =$A$3-B3 is entered in cell C3 and then copied to cell C4, the formula in cell 
C4 would be =$A$3-B4. $A$3 is an absolute reference, so it does not change; B3 is a relative refer-
ence, so it changes to B4.

The original formula shows in the Formula  
Bar and contains an absolute reference to  
cell $A$3.

View the Video “Relative and Absolute Cell References.”

Mixed Cell References
It’s also possible to create a mix between a relative and an absolute reference in a cell reference. 
For example, $A3 is a reference to cell A3 where the column reference is absolute (column A will not 
change when copied) and the row reference is relative (row 3 will change when copied). This can be 
useful when copying a formula both across a row and down a column.

After you have tapped the [F4] key once, tapping it a second time changes the absolute reference to 
a mixed reference with only a dollar $ sign in front of the row reference. A third tap of [F4] places the 
dollar $ sign in front of only the column reference, and a fourth tap removes all dollar $ signs so it is 
once again a relative cell reference.

Display and Print Formulas
To see a formula you have entered, you must first select the cell and then check the Formula Bar 
because it is the result of the formula that is displayed in the worksheet cell. This means that to check 
your formulas, you have to click each cell and review them one at a time. When you have many cells 
with formulas, this is very hard and time-consuming to do.

An easier way is to display all formulas within their cells. The Show Formulas button is a toggle that 
can be turned on and off as necessary.

You can still edit the formulas and print the worksheet while Show Formulas is turned on.

After the formula is copied, the absolute 
reference $A$3 does not change.

Tip!
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When Show Formulas is turned on, Excel automatically widens columns to show more of the cell 
contents.

Normally the cell must be selected for you to see the formula.

After turning on Show Formulas, the formulas display in the worksheet 
without selecting the cell (but you can’t see the results).

ÍÍ Formulas→Formula Auditing→Show Formulas 

DEVELOP YOUR SKILLS: E3-D3

In this exercise, you will use formulas with absolute references to find the percentage grades for the class’s 
exams and quizzes.

	 1.	 �Save your workbook as: E3-D3-FallGrades

	 2.	 �On the Exam worksheet, enter 150 in cell H5 and 40% in cell I5.

To get a grade out of 40% for each student, you need to divide their exam score by 150 then multiply 
by 40%. You will use the values in cells H5 and I5 to do this.

	 3.	 �In cell I6, type =H6/H5 but do not complete the entry.

Cell H6 shows Ashley’s total exam grade. This will change for each student when we copy the formula. 
Cell H5 is the number of total points the exam is worth, in this case 150, which should not change for 
each student; therefore, cell H5 needs to be an absolute reference.

While using [F4] to edit a formula as we will, the insertion point must be immediately before or after 
the reference to cell H5 or the correct cell reference won’t be converted.
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82  Excel Chapter 3: Performing Calculations Using Functions

	 4.	 �While still in edit mode in cell I6, tap [F4] on the keyboard to make the reference for cell H5 
absolute (dollar $ signs are placed in front of the column and row).

On some keyboards, including most laptops, you must press [Fn] (usually beside [Ctrl] near the bottom of 
the keyboard) before using the function [F] keys at the top of the keyboard because these may also be used 
for adjusting volume or other system controls.

The last step is to multiply each mark by 40%, which also does not change for each student.

	 5.	 �Continuing in edit mode in cell I6, type *I5 and tap [F4], and then click Enter .

Cell I5 is now an absolute cell reference. Ashley’s total exam grade is calculated as 33%.

	 6.	 �Copy the formula down column I for the other students.

	 7.	 �Select cell I7 and ensure the formula copied correctly. The formula should be =H7/$H$5*$I$5 
and the result for Atif is 32%.

Now you will use absolute cell references to calculate the students’ quiz grades.

	 8.	 �Click the Quizzes worksheet tab and enter 500 in cell H5 and 20% in cell J5.

	 9.	 �Enter this formula in cell J6 to calculate the quiz percentage: =H6/$H$5*$J$5 

You can decide for yourself if you would prefer to type in the dollar signs individually or use  
the [F4] key!

	10.	 �Copy the formula down column J to calculate the grades for the other students.

	11.	 �Click the Final Grades worksheet tab and notice the Final Grade now includes grades for the 
quizzes and exams, along with the grades for projects and participation.

	12.	 �Save your work.

Creating Names for Cells and Ranges
When you need to refer to the same cell or range of cells repeatedly in your formulas, consider 
creating a name for that cell or range. It’s easier to remember a name than to scroll or click around 
your workbook looking for the cells you want to use. This is especially true if you are using a cell or 
range from another worksheet or even another workbook.

Cell names cannot contain spaces.

Note!

Note!
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You can create names directly in the Name Box or via the Formulas tab on the Ribbon. You can also 
create, edit, or delete cell names using the Name Manager. Name references are automatically 
absolute cell references; that is, the reference will not change when moved or copied.

The default name 
for the selected 

cell, A1, is displayed 
in the Name Box.

ÍÍ Formulas→Defined Names

Using Cell Names in Formulas
You use a cell name in a formula just as you would any other cell reference. The cell name can be 
typed, or the cell can be selected with the mouse. You can also begin to type the first few letters of 
the name and then double-click the name from the AutoComplete list that appears.

Typing the beginning of 
the cell name will bring 
up suggested names.

The formula, after the cell name 
has been inserted, highlights the 
cell named TaxRate.

The formula’s result is displayed; 
100 multiplied by 18% is 18.

DEVELOP YOUR SKILLS: E3-D4

In this exercise, you will define names for ranges and cells, and then enter formulas to analyze and update 
the grades using those names for the cell references.

	 1.	 Save your workbook as: E3-D4-FallGrades

	 2.	 �On the Final Grades worksheet, select the range G6:G17.

	 3.	 �Click inside the Name Box, which currently displays G6, and then type Final and tap [Enter].

Final is now the name that refers to the range G6:G17. The name Final can now be used in formulas 
to analyze the grades.

The cell name in the Name Box, 
TaxRate (does not contain a space), 
refers to cell B2.
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	 4.	 �Beginning in cell I5, enter the following:

	 5.	 �Add bold and italic formatting to the range I5:I8 and AutoFit the column width to fit the text 
you just entered.

	 6.	 �In cell J6, type the formula =MAX(Final) and tap [Enter].

	 7.	 �In cell J7, type =MIN( and then use the mouse to select the range G6:G17.

Excel automatically uses the name Final inside the formula for the range you just selected.

	 8.	 �Type ) to complete the formula and then tap [Enter].

	 9.	 �Now type =AVERAGE(Fi in cell J8 and then use the mouse to double-click the name Final 
from the suggested list.

	10.	 �Type) to complete the formula and then tap [Enter].

	11.	 �Apply bold formatting and the Percent Style number format to the range J6:J8.

The highest, lowest, and average grades for the class are now displayed.

Next you will create names for the values of each part of the students’ grades. This way, if the values 
change later you can easily update the grade formulas with the new values.

	12.	 �Enter this data in the range A21:B25:

	13.	 �AutoFit the width of column A to fit the word Participation in cell A24.

	14.	 �Select cell B22 and choose Formulas→Defined Names→Define Name .

Excel adds the name Quizzes into the Name field based on the adjacent cell.

	15.	 �Ensure that Quizzes is inserted in the Name field and click OK.

	16.	 �Repeat step 14 but select cell B23 and use the proposed cell name Projects.

	17.	 �Repeat for cell B24 and cell B25, using the proposed cell names Participation and Exam, 
respectively.

	18.	 �Choose Formulas→Defined Names→Name Manager  and make sure all four names, 
as well as the name Final (five total names) have been added to the list, then close the Name 
Manager.
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	19.	 Click the Quizzes worksheet tab, select cell J5, and enter: =Quizzes

The formula enters the value from the cell named Quizzes (20%) in cell J5. If the value needs to be 
changed, it can be updated on the Final Grades sheet, and then the Quizzes sheet and all necessary 
formulas will instantly update, too.

	20.	 �Click the Exam worksheet tab, select cell I5, and enter: =Exam

	21.	 �Switch back to the Final Grades sheet and change the values in cell B22 and cell B25 to 10% 
and 50%, respectively.

The quiz grades now reflect a grade out of 10 in column C, and the exam grades reflect a grade out of 
50 in column E. Review the Quizzes and Exam sheets to see the changes there.

	22.	 �Save the workbook and close Excel.

Self-Assessment
Check your knowledge of this chapter’s key concepts and skills using the Self-Assessment in your 
ebook or online (eLab course or Student Resource Center).
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	 Reinforce Your Skills
REINFORCE YOUR SKILLS: E3-R1

Use Functions to Calculate Total and Average
In this exercise, you will update a worksheet to calculate totals for each student who volunteered at Kids 
for Change, and totals for each month of the year. You’ll find the average volunteer hours per month  
as well.

	 1.	 �Start Excel; open E3-R1-VolunteerHours from your Excel Chapter 3 folder and save it as: 
E3-R1-VolunteerTotals

	 2.	 �Select cell H5 and choose Home→Editing→AutoSum .

AutoSum finds the sum of the range D5:G5.

	 3.	 �Click Enter  to finish the entry.

The result of the formula displayed in cell H5 is 137.

	 4.	 �Use the fill handle to copy the formula in cell H5 down the column for the rest of the students.

	 5.	 �Enter the text Total in cell C28 and the text Average in cell C29.

	 6.	 �Apply bold and italic formatting to the range C28:C29, and then right-align the cell contents.

	 7.	 �Select the range D28:H28 and choose Home→Editing→AutoSum .

This time, rather than inserting the sum and copying the formula across, all five cells are filled with 
the formula instantly. If you are certain the AutoSum formula does not need to be edited, you can use 
this method.

	 8.	 �Select cell D29.

Next you will find the average. Because the average function in cell D29 will require editing, you will 
enter the first function in cell D29 and then copy across.

	 9.	 �Choose Home→Editing→AutoSum  menu button �→Average.

Notice the AVERAGE function selects the range D5:D28; this is incorrect because the average should 
not include the total in cell D28.

	10.	 �Select cell D5 and hold down the mouse button while dragging down to cell D27 to modify the 
range.

	11.	 �Once the formula displays the correct range, =AVERAGE(D5:D27), click Enter  to complete 
the formula.

	12.	 �Copy the formula in cell D29 across the row for the months of February, March, and April.

	13.	 �Save the workbook.

REINFORCE YOUR SKILLS: E3-R2

Use Absolute References and Named Ranges in Formulas
In this exercise, you will calculate a tuition payment for each of the Kids for Change student volunteers. 
You will then calculate the highest and lowest total hours volunteered.

	 1.	 �Save your workbook as: E3-R2-VolunteerTotals

	 2.	 �Enter Tuition in cell I4.


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	 3.	 �Use the Format Painter to apply the formatting from cell H4 to cell I4.

Kids for Change offers high school volunteers reimbursement for volunteer hours that they can save up 
for college tuition. First you will enter the rate and then you will multiply each student’s hours by the rate.

	 4.	 �In cell J5, type Rate and then use the Format Painter to apply the formatting from cell C29 to 
cell J5.

	 5.	 �Enter the number 3.75 in cell K5.

	 6.	 �Select cell I5 and enter a formula that multiplies cell H5 by cell K5. Be sure to use an absolute 
cell reference for cell K5 so it stays the same for each student when you copy the formula.

The result for the first student, Ashley, should be 513.75.

	 7.	 �Copy the formula down column I for the other students.

Be sure to stop at cell I27 (do not copy the formula to cell I28 in the total row). The result for the last 
student, William, should be 487.5.

The next step is to define names for the data in the Total and Tuition columns.

	 8.	 �Select the range H4:I27 and choose Formulas→Defined Names→Create from Selection .

The Create from Selection button uses the text from the selected range to define names for multiple 
columns or rows simultaneously. In this case, the text is located at the top, so the top row text values 
can be used as names for each column; for example, the name Total will refer to the range H5:H27.

	 9.	 �Ensure the Top Row box is checked and click OK.

	10.	 �In cell I28, use the SUM function to find the tuition total, taking care to use the name Tuition for 
the range.

	11.	 �Apply a bottom border to the range D27:I27 and then apply the Accounting number format to 
cell I28.

	12.	 �Adjust the rate in cell K5 to 4.25 and notice the increase in the total in cell I28.

	13.	 �Enter the text Highest in cell G30 and the text Lowest in cell G31.

	14.	 �Use the Format Painter to apply the formatting from cell C29 to the range G30:G31.

	15.	 �In cell H30, enter a formula using the MAX function to find the highest value for the total hours, 
and be sure to use the name Total for the range.

	16.	 �Enter a formula in cell H31 using the MIN function to find the lowest value and, again, use the 
name Total for the range.

	17.	 �Repeat steps 15–16 in cells I30 and I31 to find the highest and lowest values in the Tuition 
column.

	18.	 �Save and close the workbook.
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REINFORCE YOUR SKILLS: E3-R3

Calculate Funds Raised with Formulas and Functions
In this exercise, you will calculate the funds raised at the Kids for Change Summer Charity Race using the 
appropriate formulas and functions.

	 1.	 �Open E3-R3-Pledges from your Excel Chapter 3 folder and save it as: E3-R3-TotalRaised

Each participant has obtained pledges from donors at a rate of $2.50 for each mile run. The first 
step is to calculate the subtotal, which is the number of pledges multiplied by the pledge rate, then 
multiply by the number of miles each participant ran.

	 2.	 �In cell F7, insert a formula that multiplies cell D7 by cell E3 and then multiples that amount by 
cell E7.

Be sure to use an absolute cell reference to cell E3 since the pledge rate is the same for all runners.

	 3.	 �Copy the formula in cell F7 down column F for all participants.

Each participant also pays an entry fee of $25, so the fee is added to the subtotal to calculate the 
total raised.

	 4.	 �Insert a formula in cell G7 that adds cell F7 to cell E4—and remember that you don’t want the 
reference to cell E4 to change when you copy it!

	 5.	 �Copy the formula down column G.

	 6.	 �Enter the text in the cells specified:

Cell F29 Grand Total

Cell F30 Average

Cell F31 Most Raised

	 7.	 �Copy the format from cell A6 to the range F29:F31.

	 8.	 Select the range G7:G28 and name it: Total

	 9.	 �Use the name Total in functions to find the sum, average, and maximum in the appropriate cells 
in column G.

	10.	 �Apply a bottom border to cell G28 and bold format to the range G29:G31.

	11.	 �Save the workbook and close Excel.

Microsoft Excel 2019 & 365 © 2019 Labyrinth Learning – Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



Apply Your Skills  89

	 Apply Your Skills
APPLY YOUR SKILLS: E3-A1

Create an Invoice Using Formulas
In this exercise, you will create an invoice for Universal Corporate Events services using formulas with 
functions and absolute cell references. Once the appropriate formulas are entered, the invoice can be 
modified for each customer simply by changing the name, date, and number of guests at the top.

	 1.	 �Start Excel; open E3-A1-Bill from your Excel Chapter 3 folder and save it as: 
E3-A1-Invoice

There are two sections to the invoice, the flat rate fees and per person fees. For flat rate fees the 
customer pays the price plus the deposit.

	 2.	 �Use the SUM function in cell D7 to add the price plus deposit for the first item and then copy the 
formula down to cell D10.

The per-person fees must multiply the price by the number of guests, so you will do that next.

	 3.	 �In cell D14, multiply the price for meals in cell B14 by the number of guests in cell D3. Use an 
absolute reference for the cell that does not change.

	 4.	 �Copy the formula from cell D14 down to cell D17.

	 5.	 �Enter a function in cell D20 to find the subtotal, which is the sum of all item totals in column D.

Be sure to include all flat-rate fees plus all per-person fees in the subtotal. You may need to manually 
change the range since there are blank cells between the two sections.

	 6.	 �Test your formulas by changing the number of guests in cell D3 to: 150

Your subtotal should increase from $3,840 to $5,165.

	 7.	 �Save the workbook.

APPLY YOUR SKILLS: E3-A2

Calculate Tax and Discount Amount
In this exercise, you will take the Universal Corporate Events invoice and enter formulas for tax and 
discount using named cells.

	 1.	 �Save your workbook as: E3-A2-Invoice

	 2.	 �Select cell C26 and define the name TaxRate to refer to that cell.

Remember: Cell names cannot contain spaces!

	 3.	 �Use the name you just created in a formula to calculate the tax in cell D21; that is, multiply the 
subtotal by the tax rate.

Universal Corporate Events offers terms of 2/10, n/30 to their customers, which means customers get 
a 2% discount if they pay the invoice within 10 days or the net amount is due in 30 days.

	 4.	 �Create a name for cell C25 and use the name: Discount

	 5.	 �In cell D22, calculate the discount if the customer pays early using the name Discount in 
your formula.

	 6.	 �In cell D23, calculate the total due, which is the subtotal plus the tax, minus the discount.
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90  Excel Chapter 3: Performing Calculations Using Functions

	 7.	 �Test your formulas again by changing the tax and discount rates: Change the discount to zero (if 
the customer does not pay within ten days) and adjust the tax rate to 8%.

	 8.	 �Save and close the workbook.

APPLY YOUR SKILLS: E3-A3

Create Formulas Using Names
Universal Corporate Events has started a customer loyalty program. In this exercise, you will use formulas 
to calculate customer loyalty points.

	 1.	 �Open E3-A3-Customers from your Excel Chapter 3 folder and save it as: E3-A3-Points

	 2.	 �Begin by entering Points Earned in cell C5 and Total Points in cell D5.

	 3.	 �Copy the formatting from cell B5 to the range C5:D5.

	 4.	 �Enter the text Points Per Dollar in cell A25 and 15 in cell B25.

	 5.	 �Apply bold and italic formatting to the range A25:B25.

	 6.	 �In cell C6, insert a formula to calculate points for the first customer, Green Clean, by multiplying 
the total spent by the Points Per Dollar amount.

	 7.	 �Change the number format in cell C6 to Number with no decimal places.

	 8.	 �Copy the formula down the column for all customers.

All customers should show points. If any customers show 0 (zero), modify your formula to use an 
absolute cell reference.

You also want to give all of your customers a welcome bonus, which you will now add to their points 
earned.

	 9.	 �Enter the text Welcome Bonus in cell A26 and 250 in cell B26.

	10.	 �Copy the formatting from cell A25 to the range A26:B26.

	11.	 �Name cell B26: Welcome

	12.	 �Enter a formula in cell D6 to add the welcome bonus amount to the points earned for Green 
Clean, and then copy the formula down the column for all customers.

	13.	 �Enter the text Average Points Per Customer in cell A20 and then use the Average 
function in cell D20 to calculate the average points per customer.

	14.	 �Copy the formatting from cell A25 to the range A20:D20.

	15.	 �Apply Number formatting with no decimal places to cell D20.

	16.	 �Save the workbook and close Excel.
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	 	Project Grader
If your class is using eLab (labyrinthelab.com), you may upload your completed Project Grader 
assignments for automatic grading. You may complete these projects even if your class doesn’t use 
eLab, though you will not be able to upload your work.

project grader: E3-P1

Taylor Games Financial Modeling
The Taylor Games management team wants to do some what-if analysis to help them price items for retail 
sale and for sales promotions. In this exercise, you will build a model in which they can enter key values, 
and your worksheet will then automatically recalculate based upon their inputs.

	 1.	 Download and open your Project Grader starting file.

•	 Using eLab: Download E3_P1_eStart from the Assignments page. You must start with this file 
or your work cannot be automatically graded.

•	 Not using eLab: Open E3_P1_Start from your Excel Chapter 3 folder.

	 2.	 In cell E8, use a formula with cell references to multiply the Qty by the Unit Cost: (Qty * Unit 
Cost).

	 3.	 Copy the formula down to the range E9:E22.

	 4.	 In cell F8, use a formula with cell references to multiply the Inventory Value (cell E8) by the 
Markup Percentage (cell B2): (Inventory Value * Markup Percentage). Use an absolute cell ref-
erence to the Markup Percentage in cell B2.

	 5.	 Copy the formula down to the range F9:F22.

	 6.	 In cell G8, use a formula with cell references to add the Inventory Value to the Retail Markup: 
(Inventory Value + Retail Markup).

	 7.	 Copy the formula down to the range G9:G22.

	 8.	 In cell B3, create the cell name: Markdown

	 9.	 In cell H8, use a formula to multiply the Retail Value (cell G8) by the Markdown % (cell B3): 
(Retail Value * Markdown %). In your formula, use a cell reference to cell G8 and the cell name 
Markdown to reference cell B3.

	 10.	 Copy the formula down to the range H9:H22.

	 11.	 In cell I8, use a formula with cell references to subtract the Sale Markdown from the Retail 
Value: (Retail Value – Sale Markdown). 

	 12.	 Copy the formula down to the range I9:I22.

	 13.	 In the range E23:I23, use AutoSum to create column totals.

	 14.	 In cell G2, use the COUNT function to count the SKUs in the range B8:B22.

	 15.	 In cell G3, create a link to the Inventory Value total in cell E23. The cell E23 total should now 
appear in cell G3.

	 16.	 In cell G4, use the AVERAGE function to determine the average Retail Value in the range 
G8:G22.

	 17.	 In cell G5, use the AVERAGE function to determine the average Sale Value in the range I8:I22.
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	 18.	 In cell B2, enter 80 as the Markup Percentage, and in cell B3, enter 10 as the Markdown 
Percentage. Feel free to enter other numbers in cells B2 and B3 if you want to do some what-if 
analysis. But when you’re finished, make sure you have 80 in cell B2 and 10 in cell B3 if you want 
to get credit for this step.

	 19.	 Save your workbook.

•	 Using eLab: Save it to your Excel Chapter 3 folder as E3_P1_eSubmission and attach the 
file to your eLab assignment for grading.

•	 Not using eLab: Save it to your Excel Chapter 3 folder as: E3_P1_Submission

project grader: E3-P2

Classic Cars Club Rebates and Rewards Financial Model 
The Classic Cars management team is considering a Rewards & Rebates program for members. In this 
exercise, you will build a financial model with various inputs that will help them make informed decisions.

	 1.	 Download and open your Project Grader starting file.

•	 Using eLab: Download E3_P2_eStart from the Assignments page. You must start with this file 
or your work cannot be automatically graded.

•	 Not using eLab: Open E3_P2_Start from your Excel Chapter 3 folder.

	 2.	 In the Rebates & Rewards sheet, use Autofill to create a sequential list of Member #s starting 
with cells A9 and A10 and continuing down to cell A21.

	 3.	 Copy the Member #s in the range A9:A21 and paste them into the same cells in the Car Values 
sheet.

	 4.	 In cell K9 in the Car Values sheet, use a formula with cell references to subtract the Original 
Value from the Current Value: (Current Value – Original Value). 

	 5.	 In cell K9, apply the Accounting number format and decrease the decimals to zero (no decimals 
displayed).

	 6.	 Copy the formula down to the range K10:K21.

	 7.	 In cell C4, use the MAX function to determine the greatest appreciation in the range K9:K21.

	 8.	 In cell C5, use the MIN function to determine the least appreciation in the range K9:K21.

	 9.	 In cell C6, use the AVERAGE function to determine the average appreciation in the range 
K9:K21.

	 10.	 In cell C4 of the Rebates & Rewards sheet, use the COUNT function to count the Member #s 
in the range A9:A21.

	 11.	 In cell C5, create the cell name: Reward

	 12.	 In cell I9, use a formula to multiply the Contract Years (cell H9) by the Reward (Each Year) (cell 
C5): (Contract Years * Reward (Each Year)). In your formula, use a cell reference to cell H9 and 
the cell name Reward to reference cell C5.

	 13.	 Copy the formula down to the range I10:I21.

	 14.	 In cell K9, use a formula with cell references to multiply the Merchandise Purchases (cell J8) by 
the Merchandise Rebate % (cell C6): (Merchandise Purchases * Merchandise Rebate %). Use an 
absolute cell reference to the Merchandise Rebate % in cell C6.

	 15.	 Copy the formula down to the range K10:K21.
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	 16.	 In cell L9, use a formula with cell references to add the Contract Reward (I9) to the 
Merchandise Rebate (K9): (Contract Reward + Merchandise Rebate). 

	 17.	 Copy the formula down to the range L10:L21.

	 18.	 In the range I22:L22, use AutoSum to create column totals.

	 19.	 In cell C5, enter 50 as the Reward (Each Year), and in cell C6, enter 30 as the Merchandise 
Rebate %. Feel free to enter other numbers in cells C5 and C6 if you want to do some what-if 
analysis, but when you’re finished, make sure you have 50 in cell C5 and 30 in cell C6 if you want 
to get credit for this step.

	 20.	 Save your workbook.

•	 Using eLab: Save it to your Excel Chapter 3 folder as E3_P2_eSubmission and attach the 
file to your eLab assignment for grading.

•	 Not using eLab: Save it to your Excel Chapter 3 folder as: E3_P2_Submission
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	 Extend Your Skills
These exercises challenge you to think critically and apply your new skills in a real-world setting. You 
will be evaluated on your ability to follow directions, completeness, creativity, and the use of proper 
grammar and mechanics. Save files to your chapter folder. Submit assignments as directed.

E3-E1	 That’s the Way I See It
You are house shopping and have started a worksheet (E3-E1-RealEstate) to compare your top-
three properties. Open and save E3-E1-RealEstate as E3-E1-3Houses and review the overall 
structure and content. Then, enter prices for three houses you might wish to buy, using the Internet as 
necessary to research housing prices in your area. Create formulas in all gray-shaded cells, starting 
with the Down Payment cells, multiplying the price by the rate for the first house and using an abso-
lute reference so you can copy the formula across each row (subtract down payment from the price 
to find the mortgage amount). Repeat for the fees, then use the SUM function to find the total fees 
and add that to the mortgage amount to complete the Total Mortgage Plus Fees rows. Finally, apply 
appropriate cell and number formatting as desired.

E3-E2	 Be Your Own Boss
Open E3-E2-Revenue and save it as: E3-E2-Projections

Blue Jean Landscaping has four divisions, and each division has already reported their customer 
hours for Q1–Q3. You now need to calculate total invoices and make revenue projections for Q4. 
Start by calculating total hours and average hours, using the Q1–Q3 hours and the appropriate func-
tion. Then create names for the Hourly Rate and Projected Growth cells, to be used in your formulas. 
In the Total Invoices column, use a formula with the total hours and the hourly rate to calculate the 
total dollar amount for Q1–Q3. Once that is done you can calculate the Q4 projected hours using 
the average hours and multiplying by one plus the projected growth rate (in parentheses). Multiply 
the hours again by the rate to get the Q4 projected invoices. As the last step, find the total for each 
column in row 10. Format the worksheet appropriately with borders and number formatting so the 
total in row 10 stands out.

E3-E3	 Demonstrate Proficiency
After introducing two new flavors of BBQ sauce last year, Stormy BBQ wants you to do an analysis 
of its sales for each type of sauce and calculate total revenue for each. Open E3-E3-Sales; save the 
workbook as E3-E3-SauceSalesRevised and then begin by defining names for each of the 
columns of sauce data. (Hint: This can be done one column at a time or for all three columns at once 
using the Create from Selection tool.) Once you have named the three ranges, create row headings 
and insert the appropriate formulas below December to find the Total Annual Sales, Average Sales, 
Highest Sale Amount, and Lowest Sale Amount. Do this for each sauce and use the names you have 
created in your formulas. Then, create a heading and a formula to find total annual revenue for each 
sauce. Each bottle sells for $5.99. (Hint: Enter the price somewhere on the worksheet and then either 
use a name or an absolute cell reference to refer to that cell in your formula.) Apply appropriate 
formatting to the total annual revenue because this is now a dollar amount, as well as other areas of 
the worksheet as you see fit.
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